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Introduction 

The Quick Setup of the Projects module tells you how to set up projects, 

activities, journals and enter transactions quickly and perform the basic tasks you 

need to run your business.  More detailed information can be found in the various 

manuals that come along with dkBS. 
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The Projects module can be used for variety of purposes.  You may want to use 

only part of the module, or a wide range of features.  The main purpose of the 

module is to keep track of time, items and financial funds used on project-

oriented assignments.  The tree structure of projects, where projects can be 

devided into main projects and sub-projects, enables you to control very small 

tasks, as well as long-term projects for large assignments with multiple aspects of 

project handling. 

 

The main features of the Project module are: 

 project structure creation, including activities and components 

 forecast on hour-, cost-, revenue-, and item transactions 

 registration of hour, cost, and item transactions in journals 

 invoicing hour, cost and item transactions 

 data presentation through reports, inquiry grids and analysis trees 
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The Quick Setup 

The project structure 

You define the project structure in dkBS.  Projects are divided into sub-projects 

that can be divided into more projects.  A project with sub-projects is referred to 

as a parent, and sub-projects are referred to as children.  Activities can be setup 

on all project levels. 

Journals 

In the Projects module, several transactions are entered through journals.  The 

benefit of entering transactions in journals instead of posting transactions 

directly, is that transactions can be checked, printed and edited before they are 

actually posted.  Users can enter transactions in a journal during a certain period 

and at the end of the period all of the transactions can be posted (updated). 

 

Transactions can be entered in the following journal types: 

 

 Hour journals 

 Item journals 

 Cost journals 

 

 

Before we go on, let’s take a quick look at what we need to do: 

 

Step/Task Location in dkBS 

1. Create rates/items (minimum 1) Inventory – Items 

2. Link rates/items to employee Projects – Setup – Employees 

3. Create project activities Projects – Setup – Projects activities 

4. Setup (look at) general settings Projects – Setup – General settings 

5. Create customers Account receivable – Customers 

6. Create projects Projects – Projects 

7. Create projects rates Projects – Setup – Projects rates 

8. Start entering transactions in journals Projects – Projects journals 

9. View posted transactions Projects – Projects – F5 Menu 

10. Invoicing Projects – Invoice processing 

11. Adjusting transactions Projects – Inquiries – Projects – F5 

Menu – Adjust transactions 

12. Reports Projects – Reports 

13. Inquiries Projects – Inquiries 

14. Analysis Projects – Project analysis 
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Next 14 steps 

 

1. Create rates/items (cost and sales prices) 

 

Rates / items (cost and sales prices) are setup in the item table in the Inventory 

module.  These items can be of type work or service. 

 

Go to Inventory – Items 

 

 
 

Press Insert key on the keyboard, or select the [INS New ] button to create a new 

line in the items table. 

 

 
 

On the General tab you must enter a unique item code for the current item, enter 

the description for the item, select appropriate type for the item (Work, Service, 

Stock or Equipment) and group and complete entering the information in the 

applicable fields. 

On the Sale tab you must enter the VAT category for sale, the sale posting group 

and complete entering the information in the applicable fields. 

On the Purchase tab you must enter the VAT category for purchase, the purchase 

posting group and complete entering the information in the applicable fields. 
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On the Price tab, optionally, enter the cost price and the sale price. 

On the Dimension tab, optionally, select the dimensions to use when posting to 

the item and for reporting. 

 

Fields that are completed are populated either from values entered on other tabs, 

or the first values from a list of choices. 

 

Optionally, click on the [F5 Menu ] button: 

 

Click on To... 
Foreign price Set up or view foreign prices. 
Bar code Set up or view Bar codes for the selected item. 
Warehouses Set up or view item information in warehouses. 
Vendors Set up or view vendors for selected item. 

Item transactions View all transactions for the selected item. 
Item list Print a list of all your items. 
Print shelf label Print shelf label. 

Information tree                  Ctrl+T View various information regarding the vendor on a tree like 
form. 

Sales information View verious sales information for the selected item. 

Notebook Set up or view additional item information in a notebook. 
Notebook – Report Print information from the notebook, you can select sheets. 
Attached files Attache files or folders to the item.  The files can be of any 

type, i.e. doc, xls, pdf and jpg. 
Picture Set up or view picture of the selected item. 

Maintenance                                Change various fields for selected items. 
Data transfer                               Various data transfer functions 

 

Shortcut key: 

Alt + Insert  To copy information from an existing item, with all attached 

information into a new one with the same information. 

 

2. Link rates (cost and sales prices) to employee 

 

Go to Projects – Setup – Employees 

 

 
 

Press Enter or select the [ENT Change ] button for each employee that is going to 

use the Project module (entering his working time).  Then on the Project 

accounting tab you must enter appropriate rate (item from the item table). 
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You must enter Daytime rate, Overtime rate, Driving rate (Mileage rate) and 

Work time for each working day. 

 

Note.  Cost price must be entered.  It can be entered on the employee in 

“Expenses per daytime unit” or on the Item card in the cost price field.  This cost 

dose not get posted to General ledger, but is use within the Projects module in 

margin analysis. 

 

3. Create project activities 

 

Activities are specific tasks to be performed on a specific project or several 

projects.  An activity could be a specific activity on a specific construction project, 

or activity on a specific service project.  If, for instance, your project is building a 

house, it could be structured in different ways or if, for instance, your project is 

bookkeeping for a specific client, then it could also be structured in different 

ways. 

 

Example 1: A contractor has been assigned the task of building a garage.  The 

garage will be build out of wood and the customer wants electricity and light in 

the garage.  Since this is a simple project, there is no need for more than one 

level in the project structure and a reasonable setup could be like the following: 

 

Project Number (code) = 0005 Garage construction for the Johnson’s house 

 

Activities: 

 

01 Foundation 

02 Constructing the garage 

03 Wiring the garage for electricity 

04 Painting the walls 
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Example 2: An accountant has been assigned the task of keeping the company’s 

books for a specific client.  Since this is also a simple project, there is no need for 

more than one level in the project structure and a reasonable setup could be like 

the following: 

 

Project Number (code) = 0015 Company’s bookkeeping for Office Stationary Ltd. 

 

Activities: 

 

01 Bookkeeping 

02 Payroll 

03 Accounting 

04 Financial Statements 

05 Stock Investigation 

 

To create project activities, go to Projects – Setup – Project activities 

 

 
 

Press Insert key on the keyboard, or select the [INS New ] button to create a new 

line in the activities table. 

 

On the General tab you must enter a unique number (Code) for the current 

activity, enter the description and select appropriate type.  Type can be {Work, 

Sickness, Vacation, Price variation, Sickness – child, Vacation without salary and 

Payed vacation).  You can restrict the registration of transactions to activity.  On 

the Project rate tab you can enter rates, like daytime, overtime and mileage. 
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4. Setup (look at) general settings 

 

Go to Projects – Setup – General settings 

 

 

On the Project tab and Project journal tab are several setup you need to take a 

close look at.  You must tick “Use Project activities” if you want to break projects 

down to specific tasks.  You can look at activities as specific tasks to be 

performed on a specific project.  You can also tick “Use Project components”, 

which is another dimension in the Project structure, similar to activities.  You can 

look at components as specific tasks to be performed on a specific activity. 

 

If you tick “Create project for new customer” then each time you create a 

customer, a new project is created.  It is entirely up to the user to decide if he 

wants to have the system create a project automatically each time a new 

customer is created, or he creates a project manually. 

 

On the Project journal tab you could, for example tick “Description taken from 

activity description”, then when entering hour transactions in the hour journal the 

activity description is defaulted as the line text, which user can overwrite or add 

more text. 

 

When you setup the Projects module these settings, shown above, are typical for 

a small service company, that have a client base which they service on a regular 

basis and the project structure is relatively simple and no need for sub-projects. 
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5. Create customers 

 

Working with Accounts receivable involves the following: 

 Setting up specific information related to Accounts receivable (because you 

can select from the related tables in the Customer table) 

 Creating customer accounts 

 Accessing transactions 

 Recording payments 

 

Go to Accounts receivable – Customers 

 

 
 

You can create a record on each of your customer that contains basic information 

you can use throughout dkBS. 

Press Insert key on the keyboard, or select the [INS New ] button to create a new 

line in the Customer table. 

 



 

Page 13 

 
 

On the General tab you must enter a unique account number for the current 

customer, enter the name of the customer and complete entering the information 

in the applicable fields. 

On the Sale tab you must enter the posting group for the customer and complete 

entering the information in the applicable fields. 

On the Payments tab, optionally, you may enter payment term, payment mode, 

interest term and bank account information. 

On the Invoice handling tab, optionally, select how to handle invoices. 

On the CRM tab, optionally, select the contact methods and personal information. 

On the Categories tab, optionally, select the categories to use for reporting and 

analysis. 

On the Dimension tab, optionally, select the dimensions to use when posting to 

the account and for reporting. 

 

Fields that are completed are populated either from values entered on other tabs, 

or the first values from a list of choices. 

 

Optionally, click on the [F5 Menu ] button: 

 

Click on To... 
Report – Customer list Print a list of all your customers.  You have several options, you 

can select type of report and whether to print information from 
the notebook. 

Single labels Print customer information on a label. 

Customer transactions View all transactions that you have entered to the customer. 
Customers without transactions Print a list of all customers without transactions. 
Customer balance Show all customers balance in a table with drill down capability. 
Item recipients Set up or view information on item recipients. 
Contacts Set up or view information on contacts. 

Monthly totals View monthly statistics for the customer, like discounts, profit 
margin, turnover, payments and payment history. 

Information tree              Ctrl+T View all information regarding the customer on a tree like form. 
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Payment history View the payment history for the customer. 

Notebook                        Ctrl+M Set up or view additional information for the customer in a 
notebook.  The notebook can hold several sheets. 

Notebook – Report Print information from the notebook, you can select sheets. 
Properties Set up properties to the customer. 
Attached files Attache files or folders to the customer.  The files can be of any 

type, i.e. doc, xls, pdf and jpg. 
Activities  
Activity calendar  
Create customer notebook Create notebook for selected customers. 

Change customer setup Change setup parameters for customers. 
Create invoice Create a sales invoice to the customer. 
Reverse sales invoice Reverse a specific sales invoice, selected from a list. 
Read from CSV file Import customers from a CSV file.  The column in the file must 

be labeled accordingly. 
Show closed                     Ctrl+S  
Letter/Post                              Select:  Print letter/document; Sent email letter; Send email or 

Create marketing list 

 

Shortcut key: 

Alt + Insert  To copy information from an existing customer, with all attached 

information into a new one with the same information. 

 

6. Create projects 

 

In dkBS terminology, a project is a communion of sub-projects, activities (if used) 

and components (if used) with a common goal.  A project usually has limited 

resources and must meet demands regarding time and financial funds.  In 

addition, the project customer is known. 

 

 
 

The user defines the project structure in dkBS.  Projects can be created for each 

customer, only one level with no sub-projects, or projects can be devided into 

sub-projects that can be divided into more projects.  A project with sub-projects 

is referred to as a parent and sub-projects are referred to as children.  Activities 

may be setup for all projects and for all project levels.  The same applies for 

components. 

 

Project types 

The project module has four pre-defined project types: 

 

Project type Description 
Time project No fixed price is agreed upon for this kind of project.  The 

project is invoiced as work progresses.  Payment can be 
settled by means of an ordinary invoicing procedure. 

Service project Is basically the same as Time project. 
Quotation project The contractor has agreed to a fixed price contract (quote) 

before the project starts.  This kind of project can be invoiced 
and posted according to the completed percentage principle 
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or the completed contract (quote) principle. 
Internal project Usually transactions on internal projects are non-chargeable 

and no sales prices are set up on this kind of project. 
Typical internal project could be Office administration, 
Reading and research, etc. 

 

Setting up a project 

Before you begin setting up projects, it is useful to know how to work in a 

multiple project level environment or in a one project level environment. 

 

Note  It is a good idea to establish standards for how project hierarchies should 

be structured before you begin setting up projects. 

 

Note   Before setting up a project, set up the appropriate number sequence if 

you want the system to automatically allocate a number to a new project, go to 

Projects – Setup – General settings and see “4. Setup (look at) general settings“ 

 

To set up a project 

From the Projects menu, select Projects.  The projects table window opens 

 

 
 

Press Insert key on the keyboard, or select the [INS New ] button to create a new 

line in the projects table. 
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On the General tab you must enter a unique number or have the system 

automatically allocate it, enter the project name (description), Customer, Project 

type, Project status and Method of invoicing, Estimated start and complete 

entering the information in the applicable fields.  You can, optionally, enter 

owner, supervisor and employee to the project and a default activity. 

 

 
 

On the Create invoices tab you must specify how hours and cost is shown on an 

invoice (hours can be accumulated after: {Employees, Rates, Transactions, 

Project activities} and cost can be accumulated after {Item codes (rates), 

Transactions}) and how discount is calculated and complete entering the 

information in the applicable fields. 

On the Quotation info. tab, if the project type is Quotation project, you must 

enter information regarding the fixed price (quote). 

On the Service information tab, if the project type is Service project, you may 

specify service. 

On the Dimension tab, optionally, select the dimensions to use when posting to 

the project and for reporting. 

 

Fields that are completed are populated either from values entered on other tabs, 

or the first values from a list of choices. 
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Optionally, click on the [F5 Menu ] button: 

 

 
 

Click on To... 
Print project description Print a project layout with a detailed service description.  This 

layout can be tailor-made.  Go to Setup-General settings and 
click on the Project description tab 

Print service projects requests Print service requests for all projects of type Service project. 
Send service projects requests via 
Email 

Send the project layout (projects request) via Email to the 
customer, supervisor, owner or employee. 

Project description Enter a detailed description of the project. 
Notebook Set up or view additional information for the project in a 

notebook.  The notebook can have several sheets. 
Attached files Attache files or folders to the project.  The files can be of any 

type, i.e. doc, xls, pdf and jpg. 

Transactions View all transactions that you have entered to the project. 
Invoices View all invoices that have been created.  You can display and 

print the updated invoices. 
Quotes  

Registration of hours Enter and post hour transactions directly on a specific project 
(on-project transactions) 

Registration of cost Enter and post item transactions directly on a specific project 
(on-project transactions) 

Employees  
Sub-project  
Budget  
Calendar  

Information tree             Ctrl+T View various information regarding the project on a tree like 
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form. 

Recalculate project  
Recalculate project cost  
Link transactions to invoice  
Mark settlement number to the 
period 

 

Change project status  
Open/close project  

Create project invoice  

 

Shortcut key: 

Alt + Insert  To copy information from an existing project, with all attached 

information into a new one with the same information. 

 

Project stages 

Project stages are changed manually.  A full project cycle comprises the following 

stages: 

 Not started 

 In process 

 On hold 

 Finished 

The project stage is changed manually and can be changed one step ahead and 

one step backwards at a time. 

 

Entering transactions directly (on-project transactions) on projects 

On-project (by bypassing journals) transactions are entered on projects.  The 

procedure for entering on-project transactions is the same for time, service and 

quotation (fixed price) projects.  On-project transactions for these type of 

projects are entered in the same window. 

 

From the Projects menu, select Projects and select the project you want to enter 

transactions on.  Then from the F5 Menu select Registration of hours to enter 

hour transactions or select Registration of cost (items) to enter cost transactions. 

 

On-project transactions – Registration of hours 
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Select the project (Project 0116), then F5 Menu, then Registration of hours 

 

 
 

Finish entering the line and press [F12 Update ] to Update (post) the hour 

transaction on the project. 

 

On-project transactions – Registration of cost (items) 

 

Select the project (project 0116), then F5 Menu, then Registration of cost 

 

 
 

Finish entering the line and press [F12 Update ] to update (post) the item 

transaction on the project. 
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7. Create projects rates (project specific cost and sales prices) 

 

Rates / items (cost and sales prices) are setup in the item table in the Inventory 

module.  These items can be of type work or service (see “1. Create rates/items 

(cost and sales prices)” on page 7). 

 

Rates / items (cost and sales prices) that apply to projects in general will 

normally be set up in the Inventory module under Items and are then linked to 

employees.  Project specific cost and sales prices are set up in the window that 

are open via Setup – Project rates. 

 

To create projects rates, go to Projects – Setup – Project rates 

 

Press Insert key on the keyboard, or select the [INS New ] button to create a new 

line in the project rates table. 

 

On the General tab you must specify project, employee, activity, daytime rate, 

overtime rate and a description. 

 

8. Start entering transactions in journals 

 

In the Projects module, several transactions are entered through journals.  The 

benefit of entering transactions in journals instead of posting transactions directly 

(on-project transactions), is that transactions can be checked and edited before 

they are actually posted.  Users can enter transactions in a journal during a 

certain period and at the end of the period all of the transactions can be posted 

(updated). 

 

Transactions can be entered in the following journal types: 

 

 Hour journals 

 Items journals 

 Cost journals 

 

Hour journals 

In the hour journals either an indivitual employee or an administrator can enter 

the amount of hours to be registered for a specified period of time. 

 

Items journals 

In the items journal you can register inventory transactions.  Either an indivitual 

employee or an administrator can enter the items. 

 

Cost journals 

The cost journal is based on the ledger journals or vendor journals.  When 

entering a vendor invoice either in the general ledger journal or the vendor 

journal you can specify a project for the cost.  You can specify a cost price and a 

sales price.   

 

For every transaction line the type need to be Project and you need to specify 

item code (cost code).  The amount that goes to the vendor ledger is the cost 

price and then you specify the sales price. 

 

Working with journals 

Hours and costs on projects are entered in journals. 
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Enter transactions in hour journal 

From the Projects menu select Journals to open the Journals window 

 

 
 

Press Insert key on the keyboard, or select the [INS New ] button to create a new 

line in the journal table. 

Press Enter key on the keyboard, or select the [ENT Modify ] button to keep on 

entering transactions to the highlighted journal. 

 

The Time sheet window opens 

 

 
 

You enter your employee number, description for the journal and select the 

period. 

 

Then you start entering the lines. 

 

For each line you enter the posting date, project, activity, transaction text 

(description), day time hours, overtime hours, driving (mileage in km/miles or 

trips), Whether the hours and mileage will be invoiced, reference and some 

additional text (description).  You repeat the procedure, until you have finished 

entering lines. 

 

When you have enter all transaction lines, say for one month, you must exit out 

of a new line (by pressing the [ESC Exit ] button) and go to F5 Menu 
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You must check the registration to look for errors, print out the transaction lines 

in the journal and then post them. 

 

Enter transactions in cost (item) journal 

 

From the Projects menu select Journals.  Then you must select your hours journal 

and then from the [F5 Menu ] select Enter cost (items from the item table). 

 

 
 

The item journal window appears. 

 

 
 

You enter your employee number, description for the journal and select the 

period. 
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Then you start entering the lines. 

 

For each line you enter the posting date, project, activity, item code, transaction 

text (description), quantity, cost price, unit price (sales price), tick whether the 

cost is to be invoiced and reference.  You repeat the procedure, until you have 

finished entering lines. 

 

When you have enter all transaction lines, say for one month, you must exit out 

of a new line (by pressing the [ESC Exit ] button) and go to F5 Menu. You must 

check the registration to look for errors, print out the transaction lines in the 

journal and then post them. 

 

Importing external transactions in separate journals 

 

In case there is a need for receiving transactions from foreign systems, for 

example a timesheet done in MS Excel, you should use the journals for the 

reception of data.  When attempting to post the journals the system will run 

through the standard checks and thus minimize the amount of imported errors 

from the foreign system. 

 

From the Projects menu select Journals to open the Journals window, then press 

[F5 Menu ] and select “Import from Excel (.csv)“. 

 

The layout of the „csv“ file is the following: 

 

“Date;Employee;Project;Description;Hours;Overtime;Driving;Activity;Component

;Dept;Cost centre“ 

 

Date fromat is dd.mm.yyyy 

Overtime,Driving,Activity,Component,Dept and Cost centre can be left blank. 

 

This file can be created in MS Excel and saved as a csv-file. 
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9. View posted transactions 

 

Inquiries show the transactions of the selected project, employee, supervisor, 

customer or activities.  Inquiries on hour and cost transactions by project, 

employee, supervisor, customer or activity are shown in windows, very similar to 

one another. 

 

To view transaction go to the project table and from the F5 Menu select 

Transactions 

 

 
 

You see all transaction, black transactions have been invoiced, blue not and green 

are unposted transactions.  You can filter, group, sort and drill down (click the 

arrow).  Press F5 Menu for more functionality, like Adjusting the transaction (Edit 

transaction), Invoice blue transactions (Create project invoice). 

 

 
 

If you want to see transactions from unposted journals, then from the F5 Menu 

select Transactions from unposted journals. 
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To print out the inquiry, press [F7 Print ] or select from the F5 Menu other print 

options. 

 

For more inquiries go to Projects – Inquiries and then select the appropriate 

inquiry type. 

 

10.  Invoicing 

 

Invoice proposal are created as an intermediate stage between transactions 

posted in journals and the posted invoice. 

 

The following procedure details how to generate an invoice proposal. 

 

To generate invoice proposals 

 

To generate invoice proposal do one of the following: 

 Click Invoice processing in the Projects menu, click Invoices to open the 

Invoice proposal window.  Click [INS New ] button to open the Create 

Project invoices. 

 Click Projects in the Projects menu, click F5 menu and select Create project 

invoice. 

The process Create Project invoices opens 

 

 
 

You can select one project, range of projects (e.g. 0030..0042), or all projects 

that have uninvoiced transactions (leave the project number field blank). Period 

on invoice is the period to be invoiced (typical period is one month). 

 

In the lower part you must enter the invoice date and salesperson. 
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Press [F12 Confirm ] to generate invoice proposals. 

 

 
 

In the invoice proposal window you can view, update and edit preliminary invoice 

transactions. 

 

To edit an invoice proposal, click enter or double click the line to go into the 

invoice 

 

 
 

You can change the quantity on lines, lower it or rise it or you can go to view 

transaction lines (press F8 or select View project lines from the F5 Menu) and 

change Quantity sold on specific lines. 
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You can also change the sale price (Unit price). 

To view the transactions that are behind the Bookkeeping line (Quantity = 8.00) 

press from the F5 Menu View project lines or just press F8 Button. 

 

 
 

Let‘s say we want to change the quantity sold from 8 to 6.50.  We can press 

enter on the Bookkeeping line and change the Quantity to 6.50 and when the 

invoice is printed, the change (6.50) will be evently distributed to the 3 lines that 

are behind the invoice line. 

 

Or we can bring up the 3 lines by pressing the F8 button, when we have the 

bookkeeping line highlighted and then we can select the lines we want to change 

and simply enter new Quantity sold. 

 

 
 

We could e.g. change the last two lines.  First line we change Qunatity sold from 

2.00 to 1.50 and the second line we change Quantity sold from 4.00 to 3.00. 

 

 
 

Then press F12 to update it to the invoice line. 

 

You can add extra cost (items from stock or service items) to the invoice 

proposal.  From the F5 Menu, select Registration of cost. 
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Press the [F12 Update ] button to have the line updated to the invoice proposal. 

 

To print out invoice proposal, for each invoice proposal, select Print project 

invoice from the F5 Menu (F7 is short-cut key).  You can only print one invoice 

proposal at time. 

 

Rejecting invoice proposals 

 

Before invoicing multiple invoice proposals it may be necessary to reject an entire 

proposal.  To reject invoice proposals follow the procedure described below. 

 

1. Go to the invoice proposal window by selecting Invoice processing in the 

Projects menu and then select Invoices. 

2. Select the invoice proposal you want to reject. 

3. Press the [Del Delete ] button or the Delete key on the keyboard. 
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11.  Adjust transactions 

 

Cost and hour transactions that have been posted, but not yet invoiced, can be 

adjusted from the project module.  Thus the foundation of invoices can be 

changed.  One transaction line can be adjusted as a whole, or you can change 

only a part of the posted hours. 

 

To adjust transaction, go to the project table and select the project.  Then click 

[F5 Menu ] – Transactions, and then again click [F5 Menu ] and select Edit 

transaction. 

 

The following transaction characteristic can be changed. 

 

 
 

When finished making the adjustment, click [F12 Confirm ] to post the update. 

 

You can move transaction to another project by just typing in the project number. 
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12. Reports in the Projects module 

 

From the Projects menu select Reports.  Then you select the report you want to 

run. 

 

 
 

The main reports folder in Projects shows standard pre-set reports, such as 

Projects reports, Employees reports, Supervisors reports and other reports.  

There are other reports which can be found under other folders like Invoice 

processing, Budgets and Project analysis. 

 

Let’s take a look at Project – transaction list.  This report gives you several types; 

either a summary or breakdown by transactions, employees, activities or type of 

work. 
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On the Selection tab, you can restrict the report to selected projects, employees, 

activities, supervisors and period. 

On the Options tab, you can choose the breakdown, the transaction type and 

status. 

On the Project selection tab, you can choose Project type, project status and all, 

open or closed projects. 

 

Press F7 Print to print the report to printer or F6 Screen to print to the screen. 
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13. Inquiries in the Projects module 

 

From the Project menu select Inquiries.  Then you select the inquiry 

(lookup/query) you want to use. 

 

 
 

There are lots of inquiries to select, Projects inquiry, Employees inquiry, 

Transactions inquiry, Supervisors inquiry and other inquiries. 

 

Let’s take a look at Projects inquiry.  This inquiry will bring up transactions on a 

specific project for specific period and specific transaction type.  Press F6 Load to 

read in transactions. 

 

 
 

To print the transactions press [F7 Print ]. 

By pressing the F5 Menu you have several functions to select, like Edit 

transaction to adjust part of the transaction. 
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14. Analysis in the Projects module 

 

From the Project menu select Project analysis.  Then you select the analysis you 

want to run. 

 

 
 

There are lots of analysis to select, Projects analysis, Employees analysis, Key 

ratios and other analysis. 

Let’s take a look at Projects analysis tree.  This analysis will bring up tree form 

window for specific projects for specific period and specific projects type.  Press 

F12 Load to run it. 

 

 
 

To print the tree press [F7 Print ].  You can select to print the tree as it is shown, 

or only the first level or all levels (the tree expanded). 

 

You can drill down to transactions by pressing F5 Menu and then Transactions. 

You can export the tree to Excel by pressing F5 Menu and then Export to. 
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Appendix 

Understanding the Project structure 

 

Before you begin setting up projects, it is useful to know how to work in a 

multiple project level environment.  Each project set up in the Projects window 

can be a parent to any number of child projects in a parent-child-grandchild 

hierarchy.  Each child project inherits base data from the parent project. 

 

It is a good idea to establish standards for how project hierarchies should be 

structured before you begin setting up projects. 

 

If you are setting up a multiple project level environment, it can be useful to have 

the Projects window displayed in a tree view form.  To do that, select from the 

Projects menu, Setup – General settings and tick “Show projects as a tree”. 

 

 
 

Project hierarchy example 

 

A company need to keep track of time spend on activities such as meetings, 

trainings and administration.  Furthermore, they want time spent on 

administration to be broken into different kind of administration, such as time 

spend on mail, time sheets and miscellaneous.  The following structure of project 

numbers meets these demands. 
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This is one way of setting up projects.  Another way could be setting up one 

project and then creating Meetings, Education, Mail, Time sheets and 

Miscellaneous as activities. 

 

Importing external transactions in separate journals 

 

In case there is a need for receiving transactions from foreign systems, for 

example a timesheet done in MS Excel, you should use the journals for the 

reception of data.  When attempting to post the journals the system will run 

through the standard checks and thus minimize the amount of imported errors 

from the foreign system. 

 

From the Projects menu select Journals to open the Journals window, then press 

[F5 Menu ] and select “Import from Excel (.csv)“. 

 

The layout of the „csv“ file is the following: 

 

“Date;Employee;Project;Description;Hours;Overtime;Driving;Activity;Component

;Dept;Cost centre“ 

 

Date fromat is dd.mm.yyyy 

Overtime,Driving,Activity,Component,Dept and Cost centre can be left blank. 

 

This file can be created in MS Excel and saved as a csv-file.
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"Your goals need to be realistic and achievable.  If you set yourself unrealistic 

goals, you are only setting yourself up for the possibility of failure and 

disappointment.  Larger tasks should be broken down into smaller, more 

manageable ones.  This will make the large projects seem less daunting.  It will 

also give you a sense of achievement on completion.  When calculating how long 

you will need to complete a task, leave extra time in case the work takes longer 

than expected.  This will relieve the time pressure." 

 

Barbara Nance, Returning to Learning, www.bbc.co.uk 
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